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Warranty and Returned Goods Requirements
All standard Beckman Coulter, Inc. policies governing returned goods apply to this 
product. Subject to the exceptions and upon the conditions stated below, the Company 
warrants that the products sold under this sales agreement shall be free from defects in 
workmanship and materials for one year after delivery of the products to the original 
Purchaser by the Company, and if any such product should prove to be defective 
within such one year period, the Company agrees, at its option, either (1) to correct by 
repair or at the Company’s election by replacement, any such defective product 
provided that investigation and factory inspection discloses that such defect 
developed under normal and proper use, or (2) to refund the purchase price. The 
exceptions and conditions mentioned above are as follows:

a. Components or accessories manufactured by the Company which by their 
nature are not intended to and will not function for one year are warranted 
only to reasonable service for a reasonable time. What constitutes a 
reasonable time and a reasonable service shall be determined solely by the 
Company. A complete list of such components and accessories is maintained 
at the factory.

b. The Company makes no warranty with respect to components or accessories 
not manufactured by it. In the event of defect in any such component or 
accessory, the Company will give reasonable assistance to Purchaser in 
obtaining from the manufacturer’s own warranty.

c. Any product claimed to be defective must, if required by the Company, be 
returned to the factory, transportation charges prepaid, and will be returned 
to Purchaser with transportation charges collect unless the product is found 
to be defective, in which case the product must be properly decontaminated 
of any chemical, biological, or radioactive hazardous material.

d. The Company shall be released from all obligations under all warranties, 
either expressed or implied, if any product covered hereby is repaired or 
modified by persons other than its own authorized service personnel, unless 
such repair by others is made with the written consent of the Company.

e. If the product is a reagent or the like, it is warranted only to conform to the 
quantity and content and for the period (but not in excess of one year) stated 
on the label at the time of delivery.

It is expressly agreed that the above warranty shall be in lieu of all warranties of 
fitness and of the warranty of merchantability, and that the company shall have no 
liability for special or consequential damages of any kind or from any cause 
whatsoever arising out of the manufacture, use, sale, handling, repair, maintenance, or 
replacement of any of the products sold under the sales agreement.

Representatives and warranties made by any person, including dealers and 
representatives of the Company, which are consistent or in conflict with the terms of 
this warranty, shall not be binding upon the Company unless reduced in writing and 
approved by an expressly authorized officer of the Company.

Parts replaced during the warranty period are warranted to the end of the instrument 
warranty.

Note:  Performance characteristics and specifications are only warranted when 
Beckman Coulter replacement parts are used.
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1 Introducing the Biomek® FX 
Laboratory Automation 
Workstation

1.1 Introduction
Note:  Unless otherwise noted, all information in this quick-start guide refers to both 
the Biomek® FX and FXP instruments.

Welcome to the Biomek® FX Laboratory Automation Workstation. 

This quick-start guide is designed to help you learn to use Biomek Software with your 
Biomek FX. This quick-start guide includes:

• Introducing the Biomek® FX Laboratory Automation Workstation (this 
chapter) — a general hardware overview on the Biomek FX Laboratory 
Automation Workstation and introduction to the Biomek Software.

• Learning to Create Methods for the Biomek® FX (Chapter 2) — an 
overview on how to create methods using the Biomek Software.

• Using the Editors While Creating Methods (Chapter 3) — an overview on 
how to use the editors in Biomek Software to accommodate unique method 
requirements.
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1.1.1 How to Use This Quick-Start Guide
This quick-start guide is intended to help you start using the Biomek FX instrument 
and Biomek Software immediately. Read through this first chapter to acquaint 
yourself with the system, proceed to Chapter 2 and complete the tutorial steps for 
building a small method, then use Chapter 3 to complete the tutorial steps for using 
the editors for customizing a method.

To understand the depth of operating opportunities designed into this system, as well 
as to familiarize yourself with the suite of comprehensive user’s manuals made 
available at installation, links are provided throughout this guide to specific sections 
in the Biomek® FX and FX-P Laboratory Automation Workstations User’s Manual, 
the Biomek Software User’s Manual, and the ALPs User’s Manual.

In addition to the explanations, graphics, and links to other sources, you will see other 
useful information in the following forms:

Definition
These boxes contain 
brief definitions of 
material that may be 
specific to the Biomek 
FX, or generally 
unfamiliar. 

These boxes emphasize 
important concepts 
relevant to the Biomek 
FX instrument and the 
Biomek Software. Refer 
to the links in this quick-
start guide or the 
Biomek® FX and FX-P 
Laboratory Automation 
Workstations User’s 
Manual or the Biomek 
Software User’s Manual 
for more information on 
these important concepts.

Important Concept
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1.2 Biomek® FX
The Biomek FX (Figure 1-1) is a multiaxis liquid-handling instrument used in the 
laboratory. Its open-architecture design, along with the extensible operating software, 
provides a foundation for integrating current and future specific-use components. 

The Biomek FX may have one or two pods and a variety of operating components, 
such as heads, ALPs, and third party devices. Regardless of pod configuration or 
operating components, your Biomek FX is controlled through Biomek Software.

A light curtain and other protective barriers are standard with your Biomek FX (refer 
to Section 1.2.3, Light Curtain and Other Protective Barriers).

Figure 1-1.  Biomek FX main components

Protective side 
safety shield

Canopy

Front light curtain

Side light curtain

Deck
The deck is the work surface 
of the Biomek FX instrument 
and positions ALPs to be 
accessed by the pod(s). 

Multichannel 
Pod

Span-8 Pod
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1.2.1 Pods and Heads
There are two types of pods available for the Biomek FX:

• Multichannel Pod — holds various removable 
and interchangeable heads, such as the 96-
Channel 200 μL Head, that perform liquid-
handling operations, and a gripper for labware 
movement operations.

Note: Refer to the Biomek® FX and FX-P 
Laboratory Automation Workstations User’s 
Manual, Chapter 2, Multichannel Pod, for 
detailed information on the Multichannel Pod 
and interchangeable heads.

• Span-8 Pod — holds a series of eight probes 
that perform liquid-handling operations 
independent of each other. 

Note: Refer to the Biomek® FX and FX-P 
Laboratory Automation Workstations User’s 
Manual, Chapter 3, Span-8 Pod, for detailed 
information on the Span-8 Pod.

1.2.2 Automated Labware 
Positioners (ALPs)

Automated Labware Positioners (ALPs) are removable and interchangeable platform 
structures that are installed on the Biomek FX deck to allow automated assays to be 
performed.

ALPs are either active or passive:

• Passive ALPs hold labware in place on the deck or act as receptacles for 
by-products from methods, such as system fluid and disposed tips, tip boxes, 
and labware.

• Active ALPs contain mechanisms that may use power and/or air sources for 
mechanical operation, such as tip loading, tip washing, mixing/stirring, 
shaking, and precisely positioning labware.

Note:  Refer to the ALPs User’s Manual for detailed information on the ALPs on 
your system.

Heads
Interchangeable heads 
aspirate and dispense 
liquid using disposable 
tips. The tip 
compatibility and the 
maximum volume that 
may be aspirated and 
dispensed with those tips 
varies for each head.

Probes
Probes move and pipette 
independently in the D-
and Z- axes and hold the 
interface for fixed or 
disposable tips, both 
Liquid Level Sensing 
(LLS) capable and non-
LLS capable, used to 
perform liquid-handling 
operations.
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1.2.3 Light Curtain and Other Protective Barriers
WARNING: To reduce the risk of personal injury, safety shields and light 
curtain must be in place before operating. The safety shields and light 
curtain prevent entry into the work area during machine movement.
WARNING: Dark non-reflective material affects the sensitivity of the light 
curtain and adversely impact its effectiveness. Typical lab dress, such 
as lab coats and latex gloves, do not degrade light curtain operation; 
however, it is advisable to test the impact of all lab attire on light curtain 
sensitivity before operating the Biomek FX. 
The Biomek FX is equipped with protective barriers:

• Front light curtain

• Side protective shields

OR

Side light curtains

• Overhead canopy

When an object larger than approximately 1" in diameter penetrates this protective 
zone, the instrument shuts down immediately, stopping all pod and head operations. 
Some ALP operations, such as shaking or stirring, continue (refer to the ALPs User’s 
Manual). When the instrument is sitting idle or in the paused mode, no violations are 
registered when the protective zone is penetrated.
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1.3 Biomek Software
Biomek Software is designed to:

• Do a substantial amount of the method-building 
work for you.

• Allow you to take as much direct and precise 
control over the method-building process as you 
want.

The main editor that appears when the software is launched (Figure 1-2) is used to 
build and configure methods:

• Each step is dragged and dropped from a Step 
Palette into the Method View (refer to Chapter 
2, Learning to Create Methods for the Biomek® 
FX). 

• When a step in the Method View is highlighted, 
the corresponding configuration options appear 
in the Step Configuration Area (refer to Chapter 
2, Learning to Create Methods for the Biomek® 
FX).

• The method is customized to the desired level of 
precise control via the editors accessed from the 
Project and Instrument menus (refer to 
Chapter 3, Using the Editors While Creating 
Methods).

Method
A method is a series of 
steps controlling the 
operations of your 
Biomek.

Step Palettes
Step Palettes are panes 
in the Biomek main 
editor showing steps 
available for insertion in 
a method. They are 
located on the left of the 
main editor. Use the 
Step Palette Builder to 
add other step palettes. 
Refer to the Biomek 
Software User’s Manual, 
Chapter 30.5, Using the 
Step Palette Builder for 
more information.
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1.4 Starting the Biomek® FX
To start the Biomek FX, you will follow the instructions in this chapter to turn on the 
instrument, launch the Biomek Software, and home all axes.

1.4.1 Turning On the Biomek FX
To turn on the Biomek FX instrument:

1. Locate the power switch on the right side of the instrument (Figure 1-2).

2. Flip the switch to the On position. The indicator light comes on in solid green. 

1.4.2 Launching the Software
To launch the Biomek Software:

1. Choose Start>All Programs>Beckman Coulter>Biomek Software.

2. If Accounts & Permissions is enabled (see sidebar), a dialogue box appears 
requesting you to log in using the user name and password assigned to you by 
your system administrator. Enter the required information. Your account must 
have Develop Methods, Develop Projects, and Setup Instrument 
permissions to complete all parts of this quick-start guide. The Biomek Software 
main editor appears (Figure 1-2).

Note:  If you are logging into Biomek Software for the first time, you must enter 
a new password. Remember your new password; you will need to enter it each 
time you access Biomek Software.

Figure 1-2.  Biomek Software main editor

Accounts & 
Permissions

When enabled, Accounts 
& Permissions is an 
integrated set of features 
built into the software to 
assist users in complying 
with electronic signature 
requirements for closed 
systems. The 
functionality for 
Accounts & Permissions 
is included in the Biomek 
Software installation and 
provides control over 
who can create and run 
methods, and who may 
only run validated 
methods. Refer to the 
Biomek Software User’s 
Manual, Chapter 2, 
Using Accounts & 
Permissions.

Method View
The method is built 
step by step in this 
area. 

Basic Step Palette
Displays the steps 
available for insertion 
into a method. 
Additional steps are 
available through other 
step palettes.

Step Configuration Area
When a step is highlighted in the 
Method View, the corresponding 
configuration appears in this area.

Other editors are available from the 
Project and Instrument menus.

Current Deck Display
Displays the status of the deck upon 
completion of the previous step.
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1.4.3 Homing All Axes of the Biomek FX Pod
Every time the Biomek FX is turned on, you’ll have to Home All Axes. This 
automatic process initiates the pod and defines the home position from which all 
subsequent moves are determined.

To home all axes:

1. From the Instrument menu, choose Home All Axes. A Warning appears.

2. Make sure that all warnings are addressed and choose OK. The pod is homed and 
the instrument is now ready for use.

Proceed through this quick-start guide while using the links to the user’s manuals to 
learn more about the Biomek FX liquid-handling system.
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2 Learning to Create Methods for 
the Biomek® FX

2.1 Overview
In this chapter you will be given information and instructions for building a small 
method using Biomek Software. A method is a series of steps that control the 
operation of your Biomek FX. 

The method you complete in this chapter represents basic operations and is intended 
simply to familiarize you with the Biomek FX, and to create a basic understanding of 
method-building opportunities. 

Read the information in this chapter and complete the tutorial steps provided. After 
you have completed the instructions, or if you need additional information along the 
way, use the links provided to access the suite of user’s manuals provided during 
installation. These manuals include Biomek Software User’s Manual, Biomek® FX 
and FX-P Laboratory Automation Workstations User’s Manual, and ALPs User’s 
Manual. Each manual contains comprehensive information about the possibilities 
designed into the Biomek FX.

In this chapter, you’ll learn:

• Creating a New Method (Section 2.2) 

• Configuring the Instrument Setup Step (Section 2.3)

• Configuring a Transfer Step for Multichannel Pod (Section 2.4)

• Configuring a Combine Step for Span-8 Pod (Section 2.5)

• Configuring a Move Labware Step (Section 2.6)

• Using the Finish Step (Section 2.7)

• Saving a Method (Section 2.8)

• Running a Method (Section 2.9)
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2.2 Creating a New Method
In this chapter, you will build a simple method that 
transfers liquid between labware. In building this 
method, you will:

• Populate the deck with labware using the 
Instrument Setup step.

• Transfer liquid with a Multichannel Pod using a 
Transfer step.

Note: Using the Multichannel Pod requires 
that a Tip Loader ALP is installed on the deck.

• Transfer liquid with a Span-8 Pod using a Combine step.

Note: Using the Span-8 Pod requires that a Span-8 Tip Wash ALP is 
installed on the deck. A Span-8 Disposal ALP—called TipTrash in the 
Deck Editor—is required if using disposable tips. 

• Move labware with the gripper on the Multichannel Pod using a Move 
Labware step.

You launched Biomek Software in Chapter 1. You are now going to create a small 
method:

Drag and drop an Instrument Setup into the Method View. A new method is 
created and assigned the default name Method1 [New] (Figure 2-1).

Figure 2-1.  Biomek Software main editor for dual-pod Biomek FX instrument

If using Accounts & 
Permissions . . . 
You must have Develop 
Methods permission to 
create methods. Refer to 
the Biomek Software 
User’s Manual, Chapter 2, 
Using Accounts & 
Permissions, for more 
information.

Tip Loader
The Tip Loader ALP 
loads disposable tips 
onto a 96-well head or a 
384-well head mounted 
on a Multichannel Pod. 
Refer to the ALPs User’s 
Manual, Chapter 23, Tip 
Loader ALP, for more 
information.

Method View
The method is built 
step by step in this 
area. 

Step Configuration Area
When a step is highlighted in the 
Method View, the corresponding 
configuration appears in this area.

Basic Step 
Palette

Displays the steps 
available for 
insertion into a 
method. Additional 
steps are available 
through other step 
palettes.

Current Deck Display
Displays the status of the 
deck upon completion of 
the previous step.
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As you can see, two steps automatically appear in every method created and executed 
by the Biomek Software:

• Start — the first step in a method; allows 
creation of global variables that are applicable 
to the entire method. Refer to the Biomek 
Software User’s Manual, Chapter 13.2.1, 
Configuring the Start Step, for information on 
creating variables in the Start step.

• Finish — the final step in a method; provides 
options to clear the Biomek FX deck, clear the 
devices on the deck, unload tips from the pod, 
and clear all global variables. Refer to the 
Biomek Software User’s Manual, Chapter 
13.2.2, Configuring the Finish Step, for 
information on configuring other options for the Finish step.

Proceed to Section 2.3, Configuring the Instrument Setup Step to learn how to 
configure the Instrument Setup step you just inserted into the method view.

Variables
A variable is a value that 
has been assigned a 
name. that may be 
referenced repeatedly 
during a method. Refer 
to the Biomek Software 
User’s Manual, Chapter 
14, Using Variables and 
Expressions in a Method 
for more information.
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2.3 Configuring the Instrument Setup Step
CAUTION: An inaccurate Instrument Setup may result in pod and 
labware collisions, or in inappropriate pipetting.

When creating Biomek methods, it is important for obstacle avoidance (see sidebar) 
to use the Instrument Setup step, along with the Deck Editor, to tell the software 
what labware and ALPs are on the deck. You’ll learn more about the Deck Editor in 
the next chapter (refer to Section 3.5, Creating a New Deck).

Figure 2-2.  Instrument Setup step in the Method View

When building a method, 
you must ALWAYS use 
the Deck Editor and 
Instrument Setup step 
to tell the software what 
labware and ALPs are on 
the deck and the position 
each occupies. If this is 
not done, the pod could 
collide into these objects 
as it moves around the 
deck during a method.

Obstacle 
Avoidance 
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To configure the Instrument Setup step for your new method:

CAUTION: Do not place labware other than a tip box on a tip loader 
position (TL#).
1. In Deck, make sure the default deck layout (Deck1) is selected. The Instrument 

Setup step uses a deck layout as a map for the placement of labware, ALPs, and 
external hardware devices, such as stacker carousels.

2. Drag and drop the following labware on the Deck Layout Display:

• an AP96_200uL to TL1 

• a Reservoir to P4

• a BCFlat96 to P5 

• an AP96_200uL_LLS to P16; the LLS 
means these are conductive tips that enable 
liquid level sensing on a Span-8 Pod.

• a Costar384FlatSquare to P12. Your 
screen should look like Figure 2-3.

Note:  To remove unwanted labware from the Deck 
Layout Display during setup, drag and drop the 
labware to the Clear (trash) icon.

Figure 2-3.  Instrument Setup step with labware added

If you want to use a 
labware type that does 
not appear in the 
available labware list, use 
the Labware Type 
Editor to create a new 
labware type. In Section 
3.3, Creating New 
Labware in the Labware 
Type Editor, you will 
create a new labware type 
in the Labware Type 
Editor.

Creating Labware 

Liquid Level Sensing
Liquid Level Sensing 
(LLS) is used to 
determine the liquid 
level within a piece of 
labware using specially 
designed LLS tips. Refer 
to the Biomek® FX and 
FX-P Laboratory 
Automation 
Workstations User’s 
Manual, Chapter 3.3.1, 

Drag the desired 
labware graphic to 
the desired position 
on the Deck Layout 
Display.

Deck Layout 
Display

From the Deck Layout 
Display, double-click 
the labware graphic to 
display Labware 
Properties.

AP96_200uL 
on TL1

BCFlat96 
on P5

Reservoir 
on P4

AP96_20uL_LLS on P16

CostarFlat384 
on P12
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3. From the Deck Layout Display, double-click the reservoir on P4 to display 
Labware Properties (Figure 2-4).

Figure 2-4.  Labware Properties for Reservoir on P4

4. In Name, enter Resv in Labware Properties.

5. In Labware contains, select Known from the pull-down menu.

6. In volume, enter 100000. This means that you know you have 100000 
microliters of liquid in the reservoir.

7. In liquid type, select Water from the pull-down menu. Labware Properties for 
the Reservoir should look like Figure 2-4.

8. Choose OK to close Labware Properties.

9. Double-click the labware on P5 and name it Dest1 in Labware Properties.

10. In Labware contains, select Known.

11. In volume, enter 50. Labware Properties for the labware on P5 should look 
like Figure 2-5.

12. In liquid type, select Water from the pull-down menu. Labware Properties for 
the BCFlat96 should look like Figure 2-5.

13. Choose OK to close Labware Properties.

Figure 2-5.  Labware Properties for Dest1

14. Double-click the labware on P12 and name it Dest_S8 in Labware 
Properties. 

It is helpful to name 
labware, particularly 
when you use lots of 
labware on the deck. You 
can assign a name that 
identifies the contents of 
the labware or a 
descriptive name that fits 
the work being done in 
the laboratory. Naming 
labware can reduce 
confusion. 

Naming Labware 
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15. In Labware contains, select Unknown. 

16. Choose OK to close Labware Properties.

Note:  The default settings in Labware Properties will be used for the two tip 
boxes; however, you can refer to the Biomek Software User’s Manual, Chapter 
16.2.5.1, Configuring Labware Properties for Tips, to learn more about 
configuring a tip box.

17. Select Pause to confirm setup?. You will see a confirmation prompt when 
you run your method in Section 2.9, Running a Method.

18. Leave the Verify Pod Setup option as is. This setup is used to inform the 
software of the current state of the pod; for example, if the pod already has tips 
loaded.

Your Instrument Setup step is now configured and the main editor should look like 
Figure 2-6.

Note:  To learn more about the Instrument Setup step, refer to the Biomek Software 
User’s Manual, Chapter 16.2, Instrument Setup Step.

Figure 2-6.  Instrument Setup step with labware named

Next you will configure a Transfer step using a Multichannel Pod and a Combine 
step using a Span-8 Pod. If your Biomek FX instrument has only one pod, you only 
need to complete the section for the pod configuration of your instrument; however, if 
you have a dual-pod system with a Multichannel Pod and a Span-8 Pod, you may find 
it useful to complete both sections to get to know the differences between the two 
pods.
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2.4 Configuring a Transfer Step for Multichannel 
Pod

If your instrument does not have a Multichannel Pod, skip this section and continue to 
the next.

The Transfer step transfers liquid from a single source to one or more destinations. 
You are going to insert and configure a Transfer step using the Multichannel Pod into 
the method to transfer liquid from the Source reservoir to the Destination 
microplate.

Note:  For information on the extensive selections available for configuring the 
Transfer step, refer to the Biomek Software User’s Manual, Chapter 16.3, 
Configuring Transfer and Combine Steps.

2.4.1 Inserting a Transfer Step
To insert a Transfer step into your method:

Drag and drop a Transfer step from the Step Palette into the Method View just 
below the Instrument Setup step. Notice that the Current Deck Display shows 
the current position of all labware on the deck (Figure 2-7).

You’ll complete three sections to configure the Transfer step for this method:
• Section 2.4.2, Configuring Tip Handling

• Section 2.4.3, Configuring Source Labware

• Section 2.4.4, Configuring Destination Labware

Figure 2-7.  Transfer step inserted into the Method View

A Transfer step loads 
tips, aspirates and 
dispenses liquid, and 
unloads tips. This 
eliminates the need to 
insert four separate steps 
to complete a liquid 
transfer. However, there 
are steps in Biomek 
Software that allow these 
steps to be performed 
individually with a 
Multichannel Pod on the 
Intermediate Step Palette 
(refer to the Biomek 
Software User’s Manual, 
Chapter 17, Using the 
Intermediate Step 
Palette).

Transfer Step

Current Deck Display
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2.4.2 Configuring Tip Handling
To configure tip handling:

1. Make sure a Multichannel Pod is selected in Use pod. If your instrument has two 
pods, the left pod is Pod1 and the right pod is Pod2.

2. In Tip Handling, make sure Load is checked

3. Click on the AP96_200uL tip box on TL1 in the Current Deck Display to load 
AP96_200μL tips as part of the Transfer step.

4. Make sure unload them is selected in the next field.

5. Check Change tips between sources.

6. Uncheck Change tips between destinations.

7. Your tips are configured for your liquid transfer, so click the up arrow next to 
Tip Handling to collapse the configuration. This allows more room for the step 
configuration (Figure 2-8).

Figure 2-8.  Transfer step with Tip Handling collapsed

Configuring Tip 
Handling is not always 
required because the 
Biomek FX locates and 
loads clean tips 
automatically during a 
Transfer step. Refer to 
the Biomek Software 
User’s Manual, Chapter 
16.3.1, Configuring Tip 
Handling, for 
information on other tip 
handling options, such as 
Wash tips in and 
Change tips between 
destinations.

Tip Handling 

Use this arrow 
to collapse 
and expand 
Tip Handling.
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2.4.3 Configuring Source Labware
To configure the labware named Resv as source labware in the Transfer step:

1. Click on Click here to add a source.

2. Click on Resv labware sitting on P4 in the Current Deck Display.

Note:  The information you supplied during Instrument Setup is displayed in 
the source labware configuration.

3. Leave the Auto-Select checkbox selected to use the technique selected by 
Biomek Software.

4. Right-click on the large tip illustration next to the microplate graphic in the 
configuration and choose Measure from the Bottom.

5. To adjust and set the aspirate height for the depth the tip descends into the 
reservoir, place the mouse cursor over the tip illustration. When the cursor 
turns into a hand, hold the left mouse button down to move the hand up and down 
until the depth is as close to 1.00 mm from bottom as you can get. Then adjust 
the height precisely to 1.00 mm using the following note. This will be your 
aspirate height for this transfer.

Note:  After you click on the tip, you can adjust the height more precisely by 
using the up or down arrow keys on your keyboard while holding the Alt key. 
You can also right-click on the graphic, then select from the menu that appears to 
adjust the height.

The source labware configuration is complete and the main editor now looks like 
Figure 2-9.

Figure 2-9.  Transfer step with source labware configured

Techniques allow 
pipetting settings to be 
saved globally and used 
in any method. Biomek 
Software includes several 
predefined techniques. If 
Auto-Select is chosen in 
a pipetting step, such as 
Transfer, each time a 
method is created, 
Biomek Software 
automatically selects the 
technique most 
appropriate for the 
pipetting operation.

Techniques 
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2.4.4 Configuring Destination Labware
To configure the labware named Dest1 as destination labware in the Transfer step:

1. Before you configure the destination labware, click the down arrow in Transfer 
Details located just above the Current Deck Display to collapse that section. You 
will not be making any changes to the options in this section.

2. Click on Dest1 sitting on P5 in the Current Deck Display. This one operation 
accomplishes the same task as steps 1 and 2 of Section 2.4.3, Configuring Source 
Labware.)

Note:  Notice that the source labware configuration is collapsed and replaced 
with a text summary of the setup. If you want to reopen the source configuration, 
click anywhere in the collapsed area.

3. The Volume field is highlighted, which allows you to designate the amount of 
liquid to be dispensed. For this tutorial, you’re transferring 100 μL; so, type 100 
into the Volume field.

Note:  The volume is measured in microliters (μL) automatically and indicates 
the amount of liquid that will be dispensed (100 μL) into each of the 96 wells.

4. Right-click on the large tip illustration and choose Measure from Bottom.

5. Set the dispense height in the large tip illustration to 1.00 mm from bottom, 
using the same technique as you used for setting the aspirate height. The 
destination labware is now configured, and the editor looks like (Figure 2-10).

Transfer details with a 
Multichannel Pod 
include a stop condition 
for transfer operations; a 
repeat pipetting 
configuration; and a 
maximum tolerance in 
timing between transfer 
operations. Refer to the 
Biomek Software User’s 
Manual, Chapter 16.3.4, 
Configuring Transfer 
Details.

Transfer Details
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The Transfer step configuration is now complete. In the next section, you will 
configure a Combine step to transfer liquid using a Span-8 Pod. If your instrument 
does not have a Span-8 Pod, skip to Section 2.6, Configuring a Move Labware Step, 
to learn how to move labware using the gripper on the Multichannel Pod.

Figure 2-10.  Transfer step with Destination configured

Note:  The method view changes to reflect the amount transferred when the next step 
is configured.

Transfer Details

Changes to 
reflect the 
amount 
transferred 
when the next 
step is 
configured.
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2.5 Configuring a Combine Step for Span-8 Pod
If your instrument does not have a Span-8 Pod, skip this section and continue to the 
next.

The Combine step transfers liquid from one or more sources to a single destination. 
You are going to insert and configure a Combine step using a Span-8 Pod into the 
method to transfer liquid from the Source 96-well microplate to the upper left 
quadrant of the Destination 384-well microplate using the Combine step. 

Note:  For information on the extensive selections available for configuring the 
Transfer step, refer to the Biomek Software User’s Manual, Chapter 16.3, 
Configuring Transfer and Combine Steps.

2.5.1 Inserting a Combine Step
To insert a Combine step into your method:

Drag and drop a Combine step from the Step Palette into the Method View just 
before the Finish step. Notice that the Current Deck Display shows the current 
position of all labware on the deck (Figure 2-11).

You’ll complete three sections to configure the Combine step for this method:
• Section 2.4.2, Configuring Tip Handling

• Section 2.4.3, Configuring Source Labware

• Section 2.4.4, Configuring Destination Labware

Figure 2-11.  Combine step inserted into the Method View

A Combine step loads 
tips, aspirates and 
dispenses liquid, and 
unloads tips. This 
eliminates the need to 
insert four separate steps 
to complete a liquid 
transfer. However, there 
are steps in Biomek 
Software that allow these 
steps to be performed 
individually with a 
Span-8 Pod on the 
Span-8 Step Palette (refer 
to the Biomek Software 
User’s Manual, Chapter 
19, Using the Span-8 Step 
Palette).

Combine Step

Current Deck Display
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2.5.2 Configuring Tip Handling
When you are using disposable tips on the Span-8 Pod, some changes need to be 
made to the Tip Handling configuration; when you are using fixed tips, see note 
below.

Note:  When you are using fixed tips, you will use the default Tip Handling settings 
and do not need to make any changes in Tip Handling. Complete only step 6 of this 
section and continue with Section 2.5.3, Configuring Source Labware. 

To configure tip handling using disposable tips:

1. Make sure a Span-8 Pod is selected in Use pod. If your instrument has two pods, 
the left pod is Pod1 and the right pod is Pod2.

2. In Tip Handling, make sure Load is checked

3. Click on the AP96_20μL_LLS tip box in the Current Deck Display to load LLS 
tips as part of the Combine step.

4. Make sure unload them is selected in the next field.

5. Check Change tips between transfers. 

6. Your tips are configured for your liquid transfer, so click the up arrow next to 
Tip Handling to collapse the configuration. This allows more room for the step 
configuration (Figure 2-12).

Figure 2-12.  Combine step with Tip Handling collapsed

Configuring Tip 
Handling is not always 
required because the 
Biomek FX locates and 
loads clean tips 
automatically during a 
Combine step. Refer to 
the Biomek Software 
User’s Manual, Chapter 
16.3.1, Configuring Tip 
Handling, for more 
information on other tip 
handling options, such as 
Wash tips in and Wash 
tips with.

Tip Handling 

Use this arrow 
to collapse 
and expand 
Tip Handling.
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2.5.3 Configuring Source Labware
To configure the labware named Dest1 as source labware in the Combine step:

1. Click on Click here to add a source.

2. Click on the Dest1 labware sitting on P5 in the Current Deck Display.

Note:  The information you supplied during Instrument Setup is displayed in 
the source labware configuration.

3. The Volume field is highlighted, which allows you to designate the amount of 
liquid to be dispensed. For this tutorial, you’re transferring 25 μL; so, type 25 
into the Volume field.

Note:  The volume is measured in microliters (μL) automatically and indicates 
the amount of liquid that will be aspirated (25 μL) from each selected well.

4. Leave the Auto-Select checkbox selected to use the technique selected by 
Biomek Software.

5. Right-click on the large tip illustration next to the microplate graphic in the 
configuration and choose Measure from the Bottom.

6. To adjust the height precisely to 1.00 mm, click on the tip and use the up or down 
arrow keys on your keyboard while holding the Alt key.

OR

Right-click on the graphic, select Custom Height from the menu that appears, 
and enter 1.0 in Height. This will be your aspirate height for this transfer.

Techniques allow 
pipetting settings to be 
saved globally and used 
in any method. Biomek 
Software includes several 
predefined techniques. If 
Auto-Select is chosen in 
a pipetting step, such as 
Combine, each time a 
method is created, 
Biomek Software 
automatically selects the 
technique most 
appropriate for the 
pipetting operation. 

Techniques 
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The source labware configuration is complete and the main editor now looks like 
Figure 2-13.

Figure 2-13.  Combine step with source labware configured
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2.5.4 Configuring Destination Labware
To configure the labware named Dest_S8 as destination labware in the Combine 
step:

1. Click on Dest_S8 sitting on P12 in the Current Deck Display to select the 384-
well microplate as the destination.

Note:  Notice that the source labware configuration is now replaced with a brief 
sentence summary of the setup. If you want to reopen this source configuration 
for any reason, click anywhere in the collapsed configuration area.

2. Double-click on the graphic of the destination labware to zoom in on it. The 
Combine step configuration displays options for selecting the wells to access on 
the destination labware as shown in Figure 2-14.

Figure 2-14.  Combine step zoomed in on destination labware

Copy Pattern
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3. Select Use pattern to specify which wells of the 384-well microplate to 
dispense liquid using a predefined well pattern. 

4. Click on the down arrow in the field next to Use pattern to display a list of all 
the patterns defined in the Well Pattern Editor that are applicable to a 384-well 
microplate. 

5. Since you want to transfer to the upper left quadrant, select UL_quad_384. The 
labware graphic displays all the wells in the upper left quadrant as selected.

6. Choose Zoom Out to return to the Combine step configuration. The destination 
labware is now configured, and the editor looks like Figure 2-15.

Figure 2-15.  Combine step with destination labware configured

The Combine step configuration is now complete. In the next section, you will 
configure a Move Labware step to move labware using the gripper on the 
Multichannel Pod. If your instrument does not have a Multichannel Pod, skip to 
Section 2.7, Using the Finish Step, to learn how to learn how long the method will 
take to run.

Well patterns specify the 
wells of a microplate to 
aspirate to or dispense 
from. Any pattern created 
in the Well Pattern 
Editor may be used to 
specify the wells 
accessed in any step that 
aspirates or dispenses 
liquid, such as a Transfer 
or Combine step. In 
Section 3.4, Creating a 
New Pattern, you will 
learn how to create a new 
well pattern in the Well 
Pattern Editor.

Well Patterns

Transfer Details
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2.6 Configuring a Move Labware Step
Note:  If your instrument does not have a Multichannel Pod, you cannot move 
labware because your instrument does not have a gripper; continue to Section 2.7, 
Using the Finish Step. 

The Move Labware step uses the gripper to move 
labware from one position to another on the deck or from 
one ALP to another. 
Move Labware can also be used to remove labware 
from the deck or to an external hardware device without 
halting the Biomek FX or the method.

Note:  Refer to the Biomek Software User’s Manual, 
Chapter 16.4, Move Labware Step.

To configure a Move Labware step to move your Dest1 
labware at position P5 to another deck position: 

1. Insert a Move Labware step into the Method View.

2. In Move labware from, select P5 from the drop-
down menu.

3. In Move labware to, select P8 from the drop-down 
menu. The editor should now look like Figure 2-16.

Figure 2-16.  Configured Move Labware step

The Move Labware step configuration is complete. Now move on to Section 2.7, 
Using the Finish Step, to learn how long the method will take to run.

Gripper
The gripper has 
mechanical fingers that 
extend from the 
Multichannel Pod to grip 
labware. Gripper fingers 
grasp labware along the 
long side and move the 
labware from one 
location on the deck to 
another. Refer to the 
Biomek® FX and FX-P 
Laboratory Automation 
Workstations User’s 
Manual, Chapter 2.4, 
Gripper. 



2-20 Learning to Create Methods for the Biomek® FX

Beckman Coulter, Inc.

2.7 Using the Finish Step
Use the Finish step to see how long it will take to run your method.

1. Click on the Finish step in the Method View.

2. Check the status bar at the bottom of the editor for a display of the Estimated 
Time for Completion (ETC). For this method, the ETC is approximately 4:45 if 
using both a Multichannel Pod and Span-8 Pod. If using only a Multichannel 
Pod, the ETC is approximately 0:40, while the approximate time if using only a 
Span-8 Pod is 4:16. 

Note:  Your ETC may vary slightly. That’s OK. 

Note:  Refer to the Biomek Software User’s Manual, Chapter 13.2.2, Configuring the 
Finish Step, for information on configuring the Finish step.

2.7.1 Handling Configuration Errors
If there is a step configuration error in your method, the step with the error is 
highlighted in red (Figure 2-17) and the ETC is displayed as Failed when you click 
on the Finish or any step that occurs after the step with error. The error message also 
is displayed in the status bar or when hovering the mouse over the highlighted step. 
Use the message to correct the error and reconfigure the step.

Note:  Refer to the Biomek Software User’s Manual, Chapter 26, Handling and 
Preventing Errors, for more information on handling and preventing errors.

Figure 2-17.  Quick-Start method with error

Error Message
The error message 
is displayed in the 
status bar and as a 
tool tip.

ETC
Displayed as 
Failed when 
there is an error.
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2.8 Saving a Method
After you’ve clicked on Finish step, you can save your method. 

1. Choose File>Save from the toolbar. Save Method appears (Figure 2-18).

Figure 2-18.  Save Method 

2. In Method Name, enter Quick-Start Method and choose OK. The method 
editor now looks like Figure 2-19.

Saving a method 
automatically checks in 
the method, creating a 
record of the revision that 
preserves the method 
configuration at the time 
it was saved. If any of the 
project items, such as 
labware class definitions 
or techniques, changes 
after the method is saved, 
when the method is 
opened next, the latest 
definitions are used. 
Refer to the Biomek 
Software User’s Manual, 
Chapter 13, Creating and 
Using Methods.

Methods and 
Projects

Project Files
A project file stores 
information about liquid 
types; labware and tip 
types; well patterns; and 
pipetting templates and 
techniques as revisions 
that are used by a method 
file to configure the 
actions of the instrument. 
Project files store a 
history of all changes, 
additions, and deletions 
of items from the project 
file. Refer to the Biomek 
Software User’s Manual, 
Chapter 7, Understanding 
and Using Project Files.
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Figure 2-19.  Quick-Start method saved and named

Move on to Section 2.9, Running a Method, to run your saved Quick-Start method.
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2.9 Running a Method
Next you will run the method you just created using the simulator. The simulator 
allows you to watch the method on your screen without actually running the method 
on an instrument. 

To run your saved method:

1. If you do not see the Simulation Display button on the toolbar (Figure 2-21), 
from the Instrument menu, choose Hardware Setup. Biomek Hardware 
Setup appears.

Figure 2-20.  Hardware Setup

2. In Port, select Simulate. 

3. Choose Accept to save changes and close Hardware Setup. Biomek Software 
is now running in simulation mode.

When running a method 
using a Span-8 Pod, it is 
important that air be 
purged from the tubing 
and syringes before a 
method is run. Refer to 
the Biomek Software 
User’s Manual, Chapter 
13.17.6, Purging Air 
From Span-8 Pod Before 
a Method Run (FX and 
NX-S8 Only).

Purging Air from 
Span-8 Pod
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4. Click on the green arrow button on the toolbar. The simulation display is 
automatically launched and the step configuration area is replaced with a three-
dimensional model of your Biomek FX (Figure 2-21). The deck confirmation 
prompt (Figure 2-22) appears on top of the main editor.

Figure 2-21.  Biomek FX simulator displayed

Simulation display button
Click to toggle the view of the 
simulator on and off.
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Figure 2-22.  Deck confirmation prompt for Quick Start method

5. Choose OK. The prompt closes and the method continues. View the method as it 
proceeds in the simulator. The method can also be followed in the Method View 
as steps are highlighted in green as they are executed.

Note:  If you are running this method on your instrument instead of the 
simulator, make sure that the physical deck layout matches the expected deck 
layout shown in the deck confirmation prompt before you choose OK.

You can proceed directly to Chapter 3, Using the Editors While Creating Methods, to 
learn about the editors you’ll use while creating your methods.
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3 Using the Editors While 
Creating Methods

3.1 Overview
In this chapter you will be given information and instructions for using the editors in 
the Biomek Software. The editors allow you to customize a method to your special 
requirements. You can go beyond the predefined project items and instrument 
configurations; manually control the pod; restore instrument settings and project files; 
and configure external devices using specific editors. The editors are accessed from 
the Project or Instrument menus located on the toolbar of the Biomek main editor 
(Figure 3-1).

Read the information in this chapter and complete the tutorial steps provided. After 
you have completed the instructions, or if you need additional information along the 
way, use the links provided to access the Biomek Software User’s Manual.

This chapter includes the following information:

• General Description of Editors (Section 3.2)

• Creating New Labware in the Labware Type Editor (Section 3.3)

• Creating a New Pattern (Section 3.4)

• Creating a New Deck (Section 3.5)

• Manually Controlling the Pod (Section 3.6)
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3.2 General Description of Editors
Several editors are used to configure Biomek Software to control your Biomek FX 
instrument. Editors are accessed from one of two menus: 

• Project menu (Figure 3-1)

OR

• Instrument menu (Figure 3-1)

Figure 3-1.  Biomek main editor

Following is a brief description of the editors available from the two menus displayed 
in Figure 3-1. If you would like to learn more about a specific editor, refer to the 
specified chapter for more information.

You will work with three of the more commonly used editors and Manual Control in 
this quick-start guide. 

If using Accounts & 
Permissions . . . 
You must have Develop 
Projects and Setup 
Instrument permissions 
to access the editors on the 
Project and Instrument 
menus. Refer to the 
Biomek Software User’s 
Manual, Chapter 2, Using 
Accounts & Permissions, 
for more information.

Project
Includes access to the 
following:

Labware Type Editor 

Tip Type Editor

Well Pattern Editor

Technique Browser

Liquid Type Editor

Pipetting Template Editor

Instrument
Includes access to the 
following:

Hardware Setup

Deck Editor

Device Editor

Manual Control

Import/Export Utility
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3.2.1 Project Menu
The editors on the Project menu (Figure 3-1) allow project items to be created, 
copied, revised, and renamed. They include the following:

• Labware Type Editor — allows you to add new labware types, copy 
labware types, delete labware types, rename labware types, and edit labware 
type properties (refer to the Biomek Software User’s Manual, Chapter 8, 
Creating and Modifying Tip and Labware Types).

Note: Refer to Section 3.3, Creating New Labware in the Labware Type 
Editor, in this quick-start guide to follow step-by-step instructions to create 
new piece of labware.

• Tip Type Editor — allows you to add new tips types, remove tip types, and 
change tip properties (refer to the Biomek Software User’s Manual, Chapter 
8, Creating and Modifying Tip and Labware Types).

• Well Pattern Editor — allows you to create and store patterns for hitting 
specific wells (refer to the Biomek Software User’s Manual, Chapter 12, 
Creating Well Patterns).

Note: Refer to Section 3.4, Creating a New Pattern, in this quick-start 
guide to learn how to create a well pattern.

• Technique Browser — allows you to customize techniques for your 
specific needs and save them for use in future methods (refer to the Biomek 
Software User’s Manual, Chapter 10, Understanding and Creating 
Techniques).

• Liquid Type Editor — allows you to create new liquid types or to modify 
existing liquid types for methods (refer to the Biomek Software User’s 
Manual, Chapter 9, Understanding and Creating Liquid Types).

• Pipetting Template Editor — allows you to create or modify pipetting 
templates that configure the precise actions during pipetting operations 
(refer to the Biomek Software User’s Manual, Chapter 11, Using the 
Pipetting Template Editor).
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3.2.2 Instrument Menu
The editors on the Instrument menu (Figure 3-1) allow instrument configuration to 
be changed. They include the following:

• Hardware Setup — if you change the configuration of your instrument, it 
is used to install, configure, and remove other devices (refer to the Biomek® 
FX and FX-P Laboratory Automation Workstations User’s Manual, 
Appendix 4, Configuring the Biomek® FX in Hardware Setup).

• Deck Editor — used to define and change deck configurations. (refer to the 
Biomek Software User’s Manual, Chapter 6, Preparing and Managing the 
Deck).

Note: Refer to Section 3.5, Creating a New Deck, in this quick-start guide 
to follow step-by-step instructions to create a new deck layout in the 
software.

• Device Editor — external devices may be integrated to your Biomek FX 
instrument. In order to use the device, it must be configured through the 
Device Editor (refer to the Biomek Software User’s Manual, Chapter 23.4.1, 
Configuring Devices Using the Device Editor). 

• Manual Control — allows you to control the movement of the bridge, head, 
and gripper independently of a method. It is used to control the pod when 
framing the deck or gripper and when recovering from errors (refer to the 
Biomek® FX and FX-P Laboratory Automation Workstations User’s 
Manual, Chapter 6, Manually Controlling the Biomek® FX in Biomek 
Software).

Note: Refer to Section 3.6, Manually Controlling the Pod, in this quick-
start guide to learn how to manually move a pod to another position after 
using Z-Max to raise it to the highest configured height.

• Import/Export Utility — allows you to import and export instrument settings 
(decks, framing tools, pod settings) as import files (.imp) (refer to the 
Biomek Software User’s Manual, Chapter 4.4, Sharing Instrument Settings 
Using the Import/Export Utility).



Using the Editors While Creating Methods 3-5

Biomek® FX and FX-P Laboratory Automation Workstations Quick-Start Guide

3.3 Creating New Labware in the Labware Type Editor
The Labware Type Editor is used to create labware definitions so you can use 
labware that is not predefined in Biomek Software in your methods.

Assume that you have new labware that is very similar to a BCFlat96, but some 
specifications are slightly different so you must create a new labware type in the 
Labware Type Editor in order to use this new type in your methods. Refer to the 
Biomek Software User’s Manual, Chapter 8, Creating and Modifying Tip and 
Labware Types.

Note:  Do not run a method outside of the simulator using the labware you create 
here; the specifications may not be accurate for the physical piece of labware you use 
in this tutorial method (see sidebar).

To create new labware in the Labware Type Editor:

1. From the Project menu, choose Labware Type Editor. Labware Types 
appear (Figure 3-2)

Figure 3-2.  Labware Types

When creating a new 
labware type that will be 
used on your instrument, 
it is important that the 
labware dimensions are 
entered precisely per the 
manufacturer’s 
specifications. An 
incorrect labware 
definition could result in 
a number of problems, 
including collisions, 
gripper errors, or poor 
pipetting performance.

Labware 
Definitions
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2. Click on BCFlat96 and choose Copy. Copy Labware Type appears (Figure 3-
3).

Figure 3-3.  Copy Labware Type

Note:  To retain the dimensions of predefined labware in Biomek Software, it is 
important to copy and the4n edit the copy of the labware type rather than just 
editing the predefined labware to meet the new labware specifications. 

3. Enter NewLabwareQuickStart and choose OK. The copy of BCFlat96 is 
created with the specified name and appears in Labware Type Editor (Figure 3-
4).

Figure 3-4.  NewLabwareQuickStart in Labware Type Editor

Copy of BCFlat 96 renamed to 
NewLabwareQuickStart
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4. Double-click the NewLabwareQuickStart graphic. NewLabwareQuickStart 
appears (Figure 3-5).

Figure 3-5.  NewLabwareQuickStart

Note:  Each piece of labware in Labware Types has its own mini-editor similar 
to Figure 3-5 to allow specifications to be revised and saved.

5. In Height, enter 1.46 and choose Save. You have created a new piece of 
labware in the Labware Type Editor.

6. Choose Exit to close the Labware Type Editor.
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3.4 Creating a New Pattern 
The Well Pattern Editor is used to create and store patterns for accessing specific 
wells in labware. There are also pre-defined patterns in Well Patterns that may be 
used or copied to create new patterns. The patterns created and stored in Well 
Patterns are accessible in the Transfer and Combine steps using the Span-8 Pod.

To create a new well pattern based on the NewLabwareQuickStart labware you 
have created:

1. From the Project menu, choose Well Pattern Editor. Well Patterns appears 
(Figure 3-6).

Figure 3-6.  Well Patterns
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2. Choose New. New Pattern appears (Figure 3-7).

Figure 3-7.  New Pattern

3. Highlight NewLabwareQuickStart and choose OK. Figure 3-8 appears.

Figure 3-8.  Well Patterns based on Pattern 96
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4. While holding down the Shift key, select the wells for the new pattern so it looks 
like Figure 3-9.

Figure 3-9.  Wells chosen for the new pattern

5. Choose Rename to rename the new pattern. Rename Pattern appears (Figure 
3-10).

Figure 3-10.  Rename Pattern
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6. Enter LabwareQuickStart and choose OK. Figure 3-11 appears.

Figure 3-11.  New pattern renamed

7. Choose Save to save LabwareQuickStart in Well Patterns.

Note:  Refer to the Biomek Software User’s Manual, Chapter 12, Creating Well 
Patterns, for more information.
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3.5 Creating a New Deck
A deck in the Biomek Software refers to the software representation of the physical 
Biomek FX deck. The Deck Editor is used to define and change deck configurations, 
and stores deck information used for multiple methods. A deck also stores framing 
information and device associations for each position on the deck.

Assume you have added another Span-8 Wash ALP to your deck and now must create 
another deck in the Deck Editor that reflects that addition to the physical deck.

Note:  Refer to the Biomek Software User’s Manual, Chapter 6, Preparing and 
Managing the Deck, for detailed information on using the Deck Editor.

To create a new deck in the Deck Editor:

1. Choose Instrument>Deck Editor. Deck Editor appears (Figure 3-12).

Figure 3-12.  Deck Editor

2. Select New Deck. Choose a name for this deck appears (Figure 3-13).

Figure 3-13.  Choose a name for this deck

3. Enter TwoWashDeck and choose OK. TwoWashDeck appears.

4. Click and hold the mouse button on Span8WashLeft from the ALP Types List. 
Locations capable of supporting that ALP are indicted in the Deck View by 
dashed boxes.

Framing is the procedure 
of teaching the Biomek 
Software the location of 
the ALPs and devices 
positioned on the deck. 
Biomek Software uses 
this framing information 
to move the pod(s) to the 
appropriate positions to 
perform liquid-handling 
operations and 
manipulate labware. 
A Beckman Coulter 
Service Engineer frames 
the Biomek FX 
instrument during system 
installation. It may be 
necessary to repeat the 
framing if ALPs or 
devices are added, 
moved, or removed from 
the deck; the head on the 
Multichannel Pod is 
changed; or the probes on 
the Span-8 Pod are 
changed. Refer to the 
Biomek® FX and FX-P 
Laboratory Automation 
Workstations User’s 
Manual, Chapter 5, 
Framing the Biomek® 
FX.

Framing 

ALP Types List



Using the Editors While Creating Methods 3-13

Biomek® FX and FX-P Laboratory Automation Workstations Quick-Start Guide

5. Drag and drop Span8WashLeft to any location capable of supporting it (Figure 
3-14). A second Span8WashLeft has been added to the deck. This deck is now 
the default deck and is available in the Instrument Setup step.

Figure 3-14.  TwoWashDeck with second Span-8Wash added

6. Select Open Deck. Select a Deck appears (Figure 3-15).

Figure 3-15.  Select a Deck

7. Choose Deck1 to make it the default deck since it is the deck you used when you 
created the Quick-Start Method and choose OK.

8. Choose Save to exit the Deck Editor.
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3.6 Manually Controlling the Pod
If you need to manually control the Biomek FX instrument, including moving the 
bridge, head, and gripper, outside of a method, you’ll use Manual Control. Manual 
Control is also used to control the pod when framing the deck or gripper and when 
recovering from errors. Refer to the Biomek® FX and FX-P Laboratory Automation 
Workstations User’s Manual, Chapter 6, Manually Controlling the Biomek® FX in 
Biomek Software, for additional information.

Note:  Manual Control is used also for controlling individual ALPs and Device 
Controller outside a method (refer to the ALPs User’s Manual).

Using the following instructions, you’ll use Manual Control to move the pod to a 
different position on the deck. You’ll move the pod to the Z-max height first to make 
sure you don’t hit anything on the deck and then you’ll move the pod to a selected 
position.

Note:  If you launch the simulator, you can watch the pod move as you complete the 
following steps.

To move the pod(s) using Manual Control:

1. Choose Instrument>Manual Control. Manual Control appears (Figure 3-
16). Here is where you can choose to which position you want to move a pod.

Figure 3-16.  Manual Control
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2. Select Advanced Controls and highlight Pod1 or Pod2. Advanced Manual 
Control: for the selected Pod appears (Figure 3-18).

Figure 3-17.  Pod1 highlighted in Advanced Controls

Figure 3-18.  Advanced Manual Control for a Multichannel

Note:  Advanced Manual Control looks different if the selected pod is a 
Span-8 Pod.
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3. Select Move Z-Max. The Multichannel Pod moves to the highest configured 
height.

4. Select Close. Advanced Manual Control closes.

5. From Manual Control, click on P5. The Multichannel Pod moves to position P5 
on the deck.

6. You can click on additional positions to move the pod to that position. When you 
are finished moving the pod with Manual Control, choose Exit to close Manual 
Control.

7. From the toolbar, choose Close to close the quick-start method.

OR

From the File menu, choose Close. The method closes and you are now ready to 
create a method of your own. 
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3.7 Quick-Start Guide Summary
Congratulations! You’ve just completed this quick-start guide. 

You’ve completed:

• a small method

• steps using the editors

• steps to manually control the Biomek FX

If you’ve used the links to other manuals, you’ve also learned where to find hardware 
information on the Biomek FX, ALPs, and more information on Biomek Software.

Enjoy your new Biomek FX Laboratory Automation Workstation.
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